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SignalShark 3330 Outdoor Unit

Real-Time Remote Analyzer SignalShark® 3330, for the 
Detection, Analysis, Classification and Localization of RF 
Signals between 8 kHz and 8 GHz.
Supports automatic direction finding and localization via 
AoA and TDOA.
Solves complex measurement and analysis tasks reli-
ably and quickly with outstanding RF performance.
Embedded Windows 10-based open platform for 
third-party applications.

› IP65-rated robust and weatherproof die-cast alumi-
num housing

› Available in two versions
› In combination with existing infrastructure with a 

PoE connection
› Stand-alone operation with LTE modem and DC 

power supply
› Low power consumption
› Open platform

› Third party applications can also be hosted on the 
Windows 10-based device with Intel quad-core 
processor.

› Frequency range 8 kHz to 8 GHz
› Wideband frequency monitoring with an extremely fast 

scan rate of up to 50 GHz/s
› Covers whole frequency bands with a 40 MHz re-

al-time instantaneous bandwidth and a very high 
frequency resolution
› FFT overlap at least 75 %
› FFT size: up to 16 384

› Reliable signal detection due to signal duration with 
100 % POI
› > 3.125 μs without attenuation and spectral growth
› > 2 ns with attenuation proportional to the spectral 

growth
› Measures weak signals in the presence of strong 

transmitters with a receiver based High Dynamic 
Range (HDR)

› ITU-compliant measurements and applications
› Two independent FFT and receiver path allowing 

signal visualization as well as signal analysis and 
demodulation at a time.

› Common used SCPI standard for remote control
› VITA 49 streaming (sample rate up to 25.6 MHz) 

allowing storage and post processing of the signal raw 
data.

› VITA 49 FFT streaming span up to 40 MHz for over-
view display



NSTS 1223-E0369E  |  SignalShark 3330 Datasheet  |  Subject to change without notice www.narda-sts.com 2 / 19

Seven Senses for Signals 
Description 
The “SignalShark 3330 Outdoor Unit” series is characterized 
by a robust and weatherproof die-cast aluminum housing with 
IP65 protection class, which is also used as a heat sink. The 
compact size allows the receiver to be mounted close to the 
antennas, keeping the antenna cables short and the resulting 
sensitivity high.

In addition to an outstanding dynamic range, the device offers 
three switchable antenna inputs, an integrated GNSS receiver 
and the option of using automatic Narda DF antennas for direc-
tion finding and localization.

The device is designed as an “open platform”. The Windows10 
operating system allows the use of additional 3rd party software 
on the device. Despite a maximum power consumption of 40 W, 
an efficient Intel quad-core processor provides the necessary 
performance.

SignalShark 3330 versions
The different versions of the SignalShark 3330 series cover a 
wide range of applications:

3330/101 SignalShark Outdoor Unit PoE Basic Set:
Data communication and power supply are provided via a sin-
gle Gigabit Ethernet connection (PoE++). This allows the use of 
standard lightning protection components.

This product version is particularly suitable for the extension 
and modernization of existing infrastructure.

3330/102 SignalShark Outdoor Unit Modem R1 Basic Set
The data communication takes place via a mobile radio modem 
integrated in the device, which offers a direct VPN connection 
setup.

Additional monitoring software on the device allows data to be 
collected and, if necessary, compressed for transmission in the 
event of an incident.

For the power supply, a DC voltage source of 10 VDC to 30 VDC, 
such as a solar panel with rechargeable battery, can be used. 
This variant offers the greatest possible flexibility. 
For special events, an “ad hoc” monitoring network can be set 
up in a very short time.

From mounting on a lamppost to self-sufficient installation at 
the “green border” - without the need for additional infrastruc-
ture - a wide range of applications is covered.

Different versions of the “SignalShark Outdoor Unit Modem” are 
available depending on the region in which the device is to be 

used, taking into account the respective mobile radio frequency 
range. Your local Narda sales representative will be happy to 
assist you in the selection of the right version.

The Compact Monitoring Station for All Situations

Fig. 1. The SignalShark Outdoor Unit and Automatic DF antenna 
for AoA and TDOA.
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Tasks and Views
Customer applications have formed the basis for the design of 
the SignalShark family and the layout of the graphical user in-
terface (GUI). This is most clearly seen in the concept of Tasks 
and Views.

All SignalShark devices are supporting the same GUI. The 
devices can be accessed with remote desktop software via a 
network.

Tasks
Measurements often consist of a workflow of several steps, 
such as locating a signal in the spectrum, measuring its level 
and analyzing its behavior. This involves switching between dif-
ferent measurement modes and settings in each mode when a 
general-purpose analyzer is used.

However, with the SignalShark, the entire measurement work-
flow is handled by one or more measurement tasks. These tasks 
are shown as screen tabs, just like the web pages displayed by 
a web browser. Each task encapsulates all the measurement 
parameters and the underlying measurement engine mode. All 
the measurements in a task are performed at the same time. 
Up to six measurement visualizations (Views) can be added to 
adapt a task as required.

The SignalShark provides several task modes to support a 
wide variety of measurement applications.

Spectrum (Scan) Task
This task supports measurement of the spectrum over the full 
frequency span of 8 kHz to 8 GHz in a single measurement at a 
maximum measurement speed of 50 GHz/s. 

Real-Time Spectrum Task
Real-Time Spectrum task enables spectrum measurements 
with a frequency span of up to 40 MHz in real-time. All frequen-
cies within the frequency span are acquired simultaneously 
with no time gaps and with a FFT frame overlap of 75%. The 
FFT frame overlap increases to 87.5% for frequency spans of 
20 MHz or less. A second digital down converter is used at the 
same time for analyzing and demodulating the IQ data of a sep-
arate channel within the 40 MHz real-time bandwidth. The fre-
quency and bandwidth of this channel are selectable.

Auto DF Task
This task supports the use of the Narda Automatic DF Antenna 
(ADFA). Each bearing cycle can be as short as 1.2 ms and 
even the bearings of pulsed signals can be reliably determined 
as long as the minimum pulse and gap durations are somewhat 
longer than 2 cycle times. The optional available map and lo-
calization functionality, which is integrated into the SignalShark 
GUI, allows the reliable localization of transmitters. The sophis-
ticated state of the art algorithm based on the bearing statistics 

reliably eliminates the influence of false bearings on the local-
ization result, as long as there are enough line of sight bearings 
available from enough locations.

Real-Time Streaming Task
IQ data can be streamed at sample rates of up to 25.6 MHz 
using the VITA 49 protocol (option). The stream sink can be an 
external device connected via the LAN interface or a third party 
application running on the SignalShark itself for deeper analy-
sis or decoding of signals.

IQ Analyzer Task
IQ Analyzer with 1.6 GB ring buffer, real-time trigger, time do-
main analysis and spectrograms with time resolution down to 
nanoseconds. Up to 1.6 GB of IQ data can be continuously re-
corded in a ring buffer. This allows recording of a 40 MHz chan-
nel over 5 seconds. Narrower channels can be recorded for a 
correspondingly longer time. Short-term or sporadic signals can 
be detected via various trigger functions.

The recorded values can be displayed simultaneously as a IQ 
Spectrum View, IQ Spectrogram View, and a IQ Magnitude 
View. The special feature here is that it is possible to switch 
between a high time resolution and a high frequency resolu-
tion even after the measurement. This allows a signal to be 
analyzed in its entire depth. Up to eight markers support the 
determination of signal parameters.

Fig. 2. RT Spectrum view (View 1) and Spectrogram view (View 1) 
in a task (Task 2)



NSTS 1223-E0369E  |  SignalShark 3330 Datasheet  |  Subject to change without notice www.narda-sts.com 4 / 19

Views 
Measurements are visualized by means of different views. The 
frequency domain and channel level can be viewed at the same 
time, for example, by adding a spectrum view and a level meter 
view to a measurement task. Up to six views can be added to 
a task. As default each new task opens with a Spectrum view.

The currently selected view is marked by a blue border. The 
content and layout of the “Button Bar” to the right, and the 
“Measurement Information Bar” at the bottom, depends on the 
currently selected view.

The type, arrangement and size of a view can be adapted by 
the user. It is possible to save the current configuration and 
arrangement of Tasks and Views into setup files.

Tasks and Views

View

Measurement Engine or Task Mode
Spectrum 

(Scan)
RT (Real-Time) 

Spectrum
Auto DF RT Streaming IQ Analyzer

Spectrum ü RT ü ü

Peak Table (of Spectrum) ü RT ü

Spectrogram ü RT
Level Meter ü

Persistence RT
Map ü ü ü

Bearing ü

Horizontal Scan ü

IQ Magnitude (zero span, scope) ü

IQ Spectrum ü

IQ Spectrogram ü

VITA 49 FFT Streaming ü

VITA 49 IQ Streaming ü
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Device Features
Options (Views) and Scripts
An extensive set of equipment comprising frequency scanner/receiver, transmitter detector, spectrum analyzer, signal analyz-
er, directional antennas, amplifier, compass, triangulation software and maps was usually necessary in order to reliably detect, 
analyze and localize RF signals and interference. The SignalShark combines all these functions in one device.

Options (Views)
40 MHz real-time Spectrum, Marker and Peak Table (included in all Basic Sets)
A Panorama scan display that provides extremely fast scanning over the entire frequency 
range and is ideal for detecting, monitoring and analyzing any kind of signal. 
An ideal complement: Mark suspect signals in the spectrum and save them in a transmitter ta-
ble with relevant parameters such as center frequency, bandwidth, antenna type, and polariza-
tion. This table can then be recalled and worked through successively at each measurement 
location and in every operating mode of the instrument.

IQ Analyzer, Recorder, Trigger, Magn. View [option]
The IQ Analyzer is optimal when it comes to detection, analysis and documentations of hop-
ping signals as well as of interference signals caused by faulty oscillator, welding systems, 
defective relays or lamps, jammers etc. It trigger on short pulsed signals down to ns and has a 
high time resolution analysis in IQ Spectrogram View and IQ Magnitude View.

› Time Res. IQ Magnitude down to 20 ns (CBW 20 MHz, Oversampling On)
› Time Res. IQ Spectrogram down to 320 ns (CBW 20 MHz, Oversampling On, RBW 766.2 

kHz, 87.5 % Overlap)
Spectrogram [option]
The Waterfall diagram is ideal for long term monitoring of the RF spectrum and for detecting 
permanent, sporadic or frequency hopping signals. Transmitters with variable output power 
and/or bandwidth can also be identified. 
Visual representation of the recorded spectrums versus time. Colors represent the signal level. 
The smallest selectable time resolution is 31.25 μs. The high resolution makes it possible to 
display even the frame structures from for services like UMTS, LTE 5G.

Level Meter incl. Compass values [option]
The option allows you to make selective measurements at a defined frequency (Fcent) e.g. for 
monitoring the field strength of a communications channel. The measurement is in real-time 
and there are no time gaps. 
The results are shown from an independent receiver path with steep channel filters for clean 
separation of even closely spaced frequencies and has a CBW range from 25 Hz to 40 MHz 
for detection and evaluation of pulsed signals (radar) as well as broadband signals.

Persistence (of real-time Spectrum) [option]
The Polychrome spectrum displays spectra as level versus frequency where color indicates 
rate of occurrence. Persistence allows sporadic to CW (continuous waveform) signals to be 
detected easily. It can also be described as a visual detection of signal under signal, e.g. a 
detection of interferers/jammers hidden under a signal.
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Automatic DF Antenna Control, Bearing View [option]
A view for Direction finding, showing azimuth, elevation, DF quality, and omnidirectional RMS 
level derived from the Narda automatic DF antenna (ADFA). The ADFA elevation is calibrated 
between +40o und -20o.

Mapping and Localization [option]
SignalShark simplifies localization of transmitters by autonomously evaluating all the available 
bearing results and plotting them on a map. It uses a statistical distribution of bearing lines 
that represents the uncertainty in the bearing. The result is a map on which the possible loca-
tions of the transmitter are plotted and color-coded according to their probability. 
Make a drive test using a vehicle mount-adapter, combine bearings from more than 2 Sig-
nalSharks (NSL Remote DF) or mount the ADFA 2 180o upside down. There are many fea-
tures developed to facilitate and broaden the possibilities for most individual cases.
Analog Demodulation [option]
for signal identification and decoding. AM, Pulse, CW, ISB, USB, LSB, FM, PM, or IQ signals 
can be demodulated with squelch and AGC function. The demodulated signal can be stored 
as WAV-file.

Horizontal Scan [option]
plots the signal strength versus the angle of incidence on a polar diagram. The display allows 
you to more easily see the difference between the received signal and the reflections that 
occur. The SignalShark automatically calculates the bearing of the signal source based on the 
horizontally measured values.

SCPI Remote Control [option]
SCPI (Standard Commands for Programmable Instruments) is a language that makes it 
possible to control the SignalShark using standard syntax, command structure and data 
interchange format. All remote commands are described in Command reference guide for 
SignalShark  
The SCPI Remote Control allows the Narda Script Launcher to be installed.

VITA 49 [option]
is a packet-based exchange protocol for RF devices. The Vita49 standard provides a commu-
nications format that is hardware and supplier-independent 
Shows the basic measurement parameter settings while streaming IQ data according to the 
Vita 49 standard

IQ Data stream can be used for classification, decoding (3rd party SW) of signals.
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Narda Python Scripts
NSL (NardaScriptLauncher) is a free software from Narda that allows SignalShark users to select and run Python scripts from 
within the SignalShark application 

› Automate routine tasks
› Provide guided measurements for novices using message boxes or wizards
› Add new measurement evaluation functions
› Provide complete measurement automation
› New scripts constantly released to be downloaded for free
› Possibility to write programs or additions via Python, using a Narda template, customized for specific needs

NSL Remote DF (NSL Net DF)
makes it possible to create a localization with several SignalShark devices in a network.  
The user can scan the network to obtain information on all available SignalShark devices, 
synchronize all devices with configuration settings of the master device, monitor spectrum re-
ception on all devices simultaneously, and use the bearing information to perform localization 
on the master SignalShark device.

NSL Coverage Map
The user can configure settings for the coverage map and take location-dependent level mea-
surements with distinct color-coding.

Drive test for coverage, field strength correlated to color scheme

NSL DF Autopilot
The function allows the SignalShark to be connected to a navigation system. The coordi-
nates determined by the SignalShark heatmap localization are set as target in the navigation 
system, thus There is no need to look at the heatmap while driving and only one person is 
needed.

NSL Channel Scanner
A memory/frequency scan that makes it possible to monitor predefined channels in the spec-
trum. It is comparable to a channel scan on a radio. If one of the monitored channels exceeds 
a definable level value, an action (“Action”) previously defined by the user can be executed. 
It is also possible, to scan a frequency grid. This can be used to create a channel table.

NSL Limit Line
enables triggering on signals in the spectrum. The trigger level can be defined by a horizontal 
line or by a trigger mask. The trigger mask can be created and edited in the settings editor in 
various ways.
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NSL GNSS
displays information about the current GNSS reception and issues a warning message if the 
quality of the GNSS reception falls below a certain level.

NSL MS Word
takes a Word (.docx) template file as the basis for a measurement report. It reads all settings 
from the current measurement, makes a screenshot of each view and generates a measure-
ment report as MS Word document

NSL Tools
› NSL Copy Settings, copies selectable parameters such as Fcent, RBW and Attenuator from 

one task to another task.
› NSL Go 2 desktop, emulates the Windows-Key + “D-Key” keytroke to go to the Windows 

desktop
› NSL Save Peak Table, allows to save the information of a peak table in CSV format.
› NSL IQ Stream Control, allows to configure and start an IQ stream easily.
› NSL Peak trigger, uses the peak table view of SignalShark to stop the measurement when 

reaching or exceeding a user defined level.
› NSL SignalShark WOL, allows to switch on a network connected SignalShark via WakeOn-

LAN.
NSL Converter
› Convert SignalShark Spectrum Data (from HDF5 (.h5) file format to csv file format)
› Convert SignalShark Spectrogram Data (from HDF5 (.h5) file format to csv file format)
› Convert IDA (csv-based transmitter tables) to SignalShark (xml-based tansmitter tables)
› Convert SRM (csv-based transmitter tables) to SignalShark (xml-based transmitter tables)
› Convert a Template Generated CSV Table (from csv-based transmitter tables to xml-based 

transmitter tables)

NSL IQ Recorder settings 
enables the recording of IQ data in WAV format. 
Allows the user to setup and start/record the IQ streams by using SignalShark SCPI com-
mands and save them as an IQ WAV file. The WAV file format is a universal format supported 
by many monitoring software products and SDR programs.
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Definitions and Conditions

Conditions
Unless otherwise noted, specifications apply after 30 minutes warm-
up time within the specified environmental conditions. 

Specifications with limits
These describe product performance for the given parameter cov-
ered by warranty. Specifications with limits (shown as <, ≤, >, ≥, ±, 
max., min.) apply under the given conditions for the product and 
are tested during production, considering measurement uncertainty.

Specifications without limits
These describe product performance for the given parameter cov-
ered by warranty. Specifications without limits represent values with 
negligible deviations, which are ensured by design (e.g. dimensions 
or resolution of a setting parameter).

Typical values (typ.)
These characterize product performance for the given parameter 
that is not covered by warranty. When stated as a range or as a limit 
(shown as <, ≤, >, ≥, ±, max., min.), they represent the performance 
met by approximately 80% of the instruments. Otherwise, they rep-
resent the mean value. The measurement uncertainty is not taken 
into account.

Nominal values (nom.)
These characterize expected product performance for the given pa-
rameter that is not covered by warranty. Nominal values are verified 
during product development but are not tested during production.

Uncertainties
These characterize the dispersion of the values attributed to the 
measurands with an estimated confidence level of approximately 
95%. Uncertainty is stated as the standard uncertainty multiplied 
by the coverage factor k=2 based on the normal distribution. The 
evaluation has been carried out in accordance with the rules of the 
“Guide to the Expression of Uncertainty in Measurement” (GUM).
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Specificationsa

SignalShark Outdoor Unit
Frequency
Frequency range 8 kHz to 8 GHz
Scan rate > 50 GHz/s @ RBW = 1.6 MHz (resolution 800 kHz)
(basic unit, full span) 30 GHz/s (typ.) @ RBW = 100 kHz (resolution 50 kHz)
RBW (RT Spectrum) 1 Hz to 800 kHz
RBW (Scan Spectrum) 1 Hz to 6.25 MHz
CBW (Level Meter) 25 Hz to 40 MHz
EMC filter bandwidth
(Spectrum and Level Meter)

10 Hz, 100 Hz, 200 Hz, 1 kHz, 9 kHz, 10 kHz, 100 kHz, 120 kHz and 1 MHz

Detectors
(Spectrum and Level Meter)

+Pk, RMS, -Pk, Avg and Sample

CISPR Detectors (Level Meter) Cpeak (quasi-peak), CRMS & CAvg (EMC filter with CISPR bandwidth must be selected
SSB  
phase noise

fc df = 1 kHz df = 10 kHz df = 100 kHz df = 1 MHz df = 10 MHz
10 MHz < -120 dBc (1/Hz) < -130 dBc (1/Hz) < -135 dBc (1/Hz)
1 GHz < -90 dBc (1/Hz) < -101 dBc (1/Hz) < -101 dBc (1/Hz) < -112 dBc (1/Hz) < -132 dBc (1/Hz)

Internal reference frequency Deviations: < 1 ppm
(includes initial deviation, aging within the first 2 years, and temperature response)

Amplitude
HDR
(High Dynamic Range)

SignalShark can detect low level signals even in the presence of very strong signals. It does this by 
combining high sensitivity with a wide intermodulation-free dynamic range.

The DANL and IP2 / IP3 values stated below are valid at the same setting.
DANL (Noise Figure)
@ attenuator = 0 dB, 
no preamp

1 MHz ≤ f ≤ 44 MHz < - 160 dB (mW/Hz) (resultant noise figure < 14 dB)
44 MHz < f ≤ 3 GHz < - 159 dB (mW/Hz) (resultant noise figure < 15 dB)
44 MHz < f ≤ 3 GHz - 162 dB (mW/Hz) (typ.) (resultant noise figure 12 dB)
3 GHz < f ≤ 8 GHz < - 152 dB (mW/Hz) (resultant noise figure < 22 dB)

2nd order intercept 
point (IP2, 2 tones)
@ attenuator = 0 dB, 
no preamp

4 MHz ≤ f < 42 MHzb > 60 dBm
42 MHz ≤ f ≤ 8 GHz 40 dBm (typ.)

3rd order intercept 
point (IP3, 2 tones)
@ attenuator = 0 dB, 
no preamp

3 MHz < f ≤ 44 MHz > 20 dBm
3 MHz < f ≤ 44 MHz 26 dBm (typ.)
44 MHz < f ≤ 630 MHz > 4 dBm
630 MHz < f ≤ 3 GHz > 6 dBm
44 MHz < f ≤ 3 GHz 14 dBm (typ.)
3 GHz < f ≤ 8 GHz > 5 dBm
3 GHz < f ≤ 8 GHz 12 dBm (typ.)

Level uncertainty 9 kHz ≤ f ≤ 8 GHz < ± 2 dB
Residual spursc

@ attenuator = 0 dB
8 kHz ≤ f ≤ 44 MHz < -120 dBm exceptions < -100 dBm
44 MHz < f ≤ 3 GHz < -115 dBm exceptions < -100 dBm
3 GHz < f ≤ 6 GHz < -110 dBm exceptions < -95 dBm
6 GHz < f ≤ 8 GHz < -105 dBm exceptions < -85 dBm

IF rejection > 80 dB
Image rejection > 80 dB

a RF data apply in the temperature range 20 °C to 26 °C at a relative humidity of between 25 and 75 % 
b Component at f1 + f2 is measured in the direct band (Fcent ≤ 64 MHz in real-time mode)
c	 Typically	with	only	few	exceptions.	These	are	documented	in	the	calibration	certificate
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Real-Time Spectrum
Signal duration for 100 % POI @ RBW = 800 kHz > 3.125 µs without attenuation and spectral 

growth
> 2 ns with attenuation proportional to the spec-
tral growth

Spectrum rate 1.6 million spectra / s @ RBW = 800 kHz and 75 % FFT Overlap
FFT overlap Fspan > 20 MHz 75 %

Fspan ≤ 20 MHz, RBW ≤ 400 kHz 87.5 %

RF Input
Type (switchable) 3 x N-connector, 50 Ω (female)
RF destruction limit 20 dBm
Max. nominal RF level 15 dBm
Maximum DC voltage 25 V
Return loss
(VSWR)

12 kHz ≤ f ≤ 3 MHz > 9.54 dB (VSWR < 2.00)
3 GHz < f ≤ 6 GHz 12 dB (typ.) (VSWR = 1.67 (typ.))
6 GHz < f ≤ 8 GHz 10 dB (typ.) (VSWR = 1.93 (typ.))

Isolation between used and unused 
inputs

8 kHz ≤ f ≤ 1 GHz 60 dB (nom.)
3 GHz 50 dB (nom.)
8 GHz 35 dB (nom.)

General Specifications 3330/01, PoE
Attenuator 0 to 30 dB (0.5 dB steps)
Digitizer 16 bit
GNSS Embedded receiver (GPS / QZSS, GLONASS, BeiDou, Galileo)

Coordinates representation as decimal degree (DegDec - ddd.ddddd)
Internal non-removable memory ssD, mSATA 30 GB system partition 

28 GB configuration settings and user data
GNSS antenna input
(for additional, external GNSS 
antenna)

1 x SMA, 50 Ω (female) 
(DC voltage for active antennas is supplied)

Ethernet 1 x GigE (10/100/1000Base-T), RJ45
(protective housing for connector: CNLINKO, BD-24-RJ45-P02)

External power supply PoE++, 60 W
Plug type: RJ45 with waterproof housing

Passive cooling Fanless design for low maintenance operation.
Dimensionsd (H x W x D)
(incl housing, without connectors)

151 mm x 356 mm x 353 mm (5.94’’ x 14.02’’ x 13.90’’)

Weight Approx. 13 kg / 28.66 lb (with ice creation the weight can increase significantly)
Country of origin Germany

d Without antennas, stand or accessories
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General Specifications 3330/02-3, Modem R[n]
Attenuator 0 to 30 dB (0.5 dB steps)
Digitizer 16 bit
GNSS Embedded receiver (GPS / QZSS, GLONASS, BeiDou, Galileo)

Coordinates representation as decimal degree (DegDec - ddd.ddddd)
Internal non-removable memory ssD, mSATA 30 GB system partition 

28 GB configuration settings and user data
GNSS antenna input
(for additional, external GNSS 
antenna)

1 x SMA, 50 Ω (female) 
(DC voltage for active antennas is supplied)

LTE antenna connector  
(LTE antenna incl. in Set 3330/102)

1 x SMA, 50 Ω (female) 

External power supply (not incl.) Basic unit, DC input: 10 to 30 VDC, ≥ 45 W
Plug type: 3-pin with waterproof housing
(CNLINKO: BD-24-C03PE-01-002)

Passive cooling Fanless design for low maintenance operation.
Dimensionse (H x W x D)
(incl. housing, without connectors)

151 mm x 356 mm x 353 mm (5.94’’ x 14.02’’ x 13.90’’)

Weight Approx. 13 kg / 28.66 lb (with ice creation the weight can increase significantly)
Country of origin Germany

Specifications 3330/02, Modem R1
R[n]f

Frequencies
Region 1: Europeg, The Middle East, Africa
4G (LTE-FDD): B1, B3, B5, B7, B8, B20
4G (LTE-TDD): B40
3G: B1, B5, B8
2G: B3, B8

RUT241 RF technologies 2G, 3G, 4G
Max RF power 33 dBm @GSM, 24 dBm @WCDMA, 23 dBm @LTE
Transmission rates 4G (LTE) – Cat 4 up to 150 Mbps, 3G – Up to 42 Mbps, 2G – Up to 236.8 kbps

RUT241 router must be used in compliance with any and all applicable national and international laws and with any special 
restrictions regulating the utilization of the communication module in prescribed applications and environments.

External antennas used with RUT241 must be installed to provide a separating distance of at least 20 cm from all persons and 
must not be co-located or operated in conjunction with any other antenna or transmitter.

Any external antenna gain must meet RF exposure and maximum radiated output power limits of the applicable rule section.

Failure to observe these instructions could result in your RF exposure exceeding the relevant guideline limits.

e Without antennas, stand or accessories
f R[n]: Respective region in which the installed LTE router can be used.
g Regional availability - excluding Russia & Belarus.
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Remote Control and Streaming
Remote control protocol SCPI
FFT streaming VITA49 compliant
IQ streaming VITA49 IQ streaming, sample rate up to 25.6 MHzh, i 
Remote Software Remote Desktop for PC, Tablet and Smartphone (Windows, Android, IOS)

Additional Functions
Noise power density measurement Can be measured with up to eight markers at a time.
Channel power measurement Can be measured with up to eight markers at a time.
Occupied bandwidth measurement According to ITU-R SM.443-4, with additional automatic center frequency and channel power mea-

surement. Can be measured with up to eight markers at a time.
Field strength measurement According to ITU-R SM.378-7
CISPR Detectors Cpeak (quasi-peak), CRMS & CAvg (EMC filter with CISPR bandwidth must be selected)
Modulation detectors AM, FM and PM. Up to 4 different detectors are available simultaneously
Frequency offset measurement For CBW ≤ 1 MHz (using modulation detectors)
Analog demodulation and recording AM, Pulse, CW, ISB, USB, LSB, FM, PM, or IQ signals can be demodulated with squelch and AGC 

function. The demodulated signal can be stored as WAV-file.
Tone search The level of one of the detectors modulates the pitch of an audible tone.
Automatic DF Automatic bearing of transmitters using a Narda Automatic DF Antenna.
Automatic transmitter localization 
(Heatmap)

Automatic calculation of the transmitter location.

TDOA localizationj Integrated GPS with high-accuracy timestamp for TDOA applications. With additionally available 
software package

Environmental Conditions
MIL-PRF-28800F Class 2 Operating temperaturek 

Storage temperature
Operating humidity
Random vibration
Functional shock
Transit drop

Operating temperature -20 °C to + 55 °C
Humidity < 29 g/m³ (< 93 % RH at +30 °C)
IP class IP 65
Climate Storage 1K3 (IEC 60721-3) extended to - 40 °C to + 70 °C

Transport 2K4 (IEC 60721-3) restricted to - 40 °C to + 70 °C
Operating 7K2 (IEC 60721-3) extended to - 20 °C to + 55 °C

Mechanical Storage 1M3 (IEC 60721-3)
Transport 2M3 (IEC 60721-3)
Operating 7M3 (IEC 60721-3)

Compliance
EMC European Union Complies with RED Directive 2014/53/EU and EN 301 489-1 V2.2.3, EN 301 489-52 V1.2.1, EN 301 

511 V12.5.1, EN 301 908-2 V13.1.1, EN 301 908-13 V13.2.1, EN 301 908-1 V15.1.1, EN 61326-
1:2021

Immunity IEC/EN: 61000-4-2, 61000-4-3, 61000-4-4, 61000-4-5, 61000-4-6, 61000-4-11
Emission IEC/EN: 61000-3-2, 61000-3-3, IEC/EN 55011 (CISPR 11) Class B

Safety Complies with European Low Voltage Directive 2014/35/EU and IEC/EN 61010-1:2010
Material Complies with European RoHS Directive 2011/65/EU, (EU)2015/863 and EN 63000:2018

h Applies for integrated 1 Gbit Ethernet interface.
i 25.6 MHz IQ data streaming is not possible due to bandwidth limitation caused by the modem and/or 100 Mbit LAN.
j Requires additional software
k For low-maintenance operation, the system is passively cooled and therefore requires no fan. Protection against direct sunlight must be provided!
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Drawing - SignalShark 3330/xx

All dimensions are given in mm. 
The actual connectors depend on the selected device version.

Also consider the space needed for mounting adapters, wall mount adapter or mast mount adapter
For low-maintenance operation, the system is passively cooled and therefore requires no fan. 
Protection against direct sunlight must be provided!
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Ordering Information
The SignalShark Outdoor Unit is included in the Basic Sets. Application Packages as well as Software Options and Accessories 
that provide additional signal analysis capabilities are also available.  
Your local Narda sales representative can provide information about all the possible options and will be pleased to offer advice.

Basic Unit Sets
SignalShark Outdoor Unit PoE Basic Set Part number
The Basic set contains the “SignalShark Outdoor Unit, PoE”, as well as basic accessories and supports 40 
MHz real-time spectrum analysis, marker, peak table and SCPI remote control functions.

3330/101

Includes:
› SignalShark Outdoor Unit, PoE
› RJ-45-Plug waterproof
› PoE++ Injector, 60 W
› Wall Mount Bracket for SignalShark 3330
› Option, SCPI Remote Control
› USB Stick: SW and Manuals, ordered options
› SignalShark 3330 - Quick Start and Safety Instructions

SignalShark Outdoor Unit Modem R1 Basic Set* Part number
The Basic set contains the “SignalShark Outdoor Unit, Modem R1”, as well as basic accessories and sup-
ports 40 MHz real-time spectrum analysis, marker, peak table and SCPI remote control functions.

3330/102

(only available in countries 
with corresponding radio 
approval)

Includes:
› SignalShark Outdoor Unit, Modem R1
› DC-Plug waterproof
› LTE Antenna
› Wall Mount Bracket for SignalShark 3330
› Option, SCPI Remote Control
› USB Stick: SW and Manuals, ordered options
› SignalShark 3330 - Quick Start and Safety Instructions

* Europe only (Regional availability - excluding Russia & Belarus.). 
For other regions, please contact your local Narda sales representative for further information.
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Application Packages
The application packages make it easy to adapt SignalShark to your requirements. Each package typically consists of applica-
tion-dependent hardware accessories and/or firmware options, and costs less than purchasing the items individually. Additional 
packages can be purchased as and when required.  
Your local Narda sales representative will be happy to assist you in the selection of the right packages for your applications.

App. Package, Receiver Part number
The Receiver Application Package guarantees situational awareness by providing gapless analysis of entire 
signal bands. It also enables demodulation of AM, FM, LSB, USB, and CW signals.

3310/94.01

Includes:
› Option, Spectrogram (3310/95.002)
› Option, Level Meter incl. Compass values (3310/95.003)
› Option, Analog Demodulation (3310/95.007)

App. Package, Automatic DF 2, 10 MHz to 8 GHz * Part number
This Application Package provides basic equipment and options for vehicle based, automatic direction finding 
(bearing).

3310/94.06

Includes:
› Automatic DF-Antenna 2 (3361/01)
› USB Stick: Software and Manuals, ordered Options (3310/93.01)
› RF-Cable, DC to 8 GHz, N to SMA, 50 Ohm, 5 m (3603/02)
› Option, Automatic DF Antenna Control, Bearing View (3310/95.005)
› Tool, Allen Wrench 3 mm (3300/90.19)
› ADFA Vehicle Mounting Kit for autom. DF Antenna (3300/90.04)  

incl. the “Automatic DF-Antenna Handling and Safety Instructions” multilingual (3360/98.12)
› Shipping Carton with Inlet for autom. DF-Antenna

*Additional option 3310/95.006 “Mapping and Localization” is recommended for Open Street Map based visualization and heat-
map localization.

App. Package, Automatic DF 2, 10 MHz to 8 GHz, Hardcase * Part number
This Application Package provides basic equipment and options for vehicle based, automatic direction finding 
(bearing).

3310/94.12

Includes:
› Automatic DF-Antenna 2 (3361/01)
› USB Stick: Software and Manuals, ordered Options (3310/93.01)
› RF-Cable, DC to 8 GHz, N to SMA, 50 Ohm, 5 m (3603/02)
› Option, Automatic DF Antenna Control, Bearing View (3310/95.005)
› Tool, Allen Wrench 3 mm (3300/90.19)
› ADFA Vehicle Mounting Kit for autom. DF Antenna (3300/90.04) 

incl. the “Automatic DF-Antenna Handling and Safety Instructions” multilingual (3360/98.12)
› Hardcase for Automatic DF Antenna (3360/90.01)

*Additional option 3310/95.006 “Mapping and Localization” is recommended for Open Street Map based visualization and heat-
map localization.
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Software Options
Software options allows the adaption of the device feature set to your needs.

Description Part number
40 MHz real-time Spectrum, Marker and Peak Table (included in SignalShark 3330 Basic Set). 

Via the “Spectrum (Scan)”-, “RT (Real-Time) Spectrum”- “Auto DF”-, and “IQ Analyzer”-Tasks, the following 
View(s) can be accessed:

› Spectrum View
› Peak Table (of Spectrum) View

Included in Basic Set

Option, Spectrogram 

Via the “Spectrum (Scan)”- and “RT (Real-Time) Spectrum”-Tasks, the following View(s) can be accessed:
› Spectrogram View

3310/95.002

Option, Level Meter incl. Compass values 

Via the “RT (Real-Time) Spectrum”-Task, the following View(s) can be accessed:
› Level Meter View

3310/95.003

Option, Persistence (of real-time Spectrum) 

Via the “RT (Real-Time) Spectrum”-Task, the following View(s) can be accessed:
› Persistence View

3310/95.004

Option, Automatic DF Antenna Control, Bearing View 

Via the “Auto DF”-Task, the following View(s) can be accessed:
› Bearing View

3310/95.005

Option, Mapping and Localization 

Via the “Spectrum (Scan)”-, “RT (Real-Time) Spectrum”-, and “Auto DF”-Tasks, the following View(s) can be 
accessed:

› Map View

3310/95.006

Option, Analog Demodulation 

Via the “RT (Real-Time) Spectrum”-Task, the following View(s) can be accessed:
› Spectrum View
› Level meter View

3310/95.007

Option, Horizontal Scan 

Via the “RT (Real-Time) Spectrum”-Task, the following View(s) can be accessed:
› Horizontal Scan View

3310/95.011

Option, SCPI Remote Control (included in SignalShark 3330 Basic Set) 3310/95.12
Included in Basic Set

Option, VITA 49l  

Via the “RT Streaming”-Task, the following View(s) can be accessed:
› VITA 49 FFT Streaming View
› VITA 49 IQ Streaming View

3310/95.014

Option, IQ Analyzer, Recorder, Trigger, Magn. View 

Via the “IQ Analyzer”-Task, the following View(s) can be accessed:
› IQ Magnitude View
› IQ Spectrum View
› IQ Spectrogram View

3310/95.018

l Requires Option 3310/95.012 “Option, SCPI Remote Control”
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Accessories
Accessory Description Part number
PoE++ Injector, 60W (please select country specific power cord). 3330/90.01
Universal Surge Arrester for GBit Ethernet (DEHN 929 221) 3330/90.06
RF Adapter, N Male to SMA Female, 50 Ohm 3330/90.13
GNSS Antenna, Screw Mounting, Active 3330/90.04
LTE Antenna 3330/90.05
Mast Mounting Adapter for 3330/XX, D: 48mm to 200 mm 3330/90.07
Recovery media for SignalShark Quad Core 3310/90.25
RF and Control-Cable for Automatic DF-antennas, DC to 8 GHz, N to SMA,  50 Ohm,  5 m 3603/02
RF and Control-Cable for Automatic DF-antennas, DC to 8 GHz, N to SMA,  50 Ohm,  15 m 3603/03
RF and Control-Cable for Automatic DF-antennas, DC to 8 GHz, N to SMA,  50 Ohm,  10 m 3603/07
Tripod, Non-Conductive, 1.65m, reinforced, 3/8”-16 UNC (for ADFA 2 only) 3300/90.16
Tripod Quick-Release Coupling, 3/8”-16 UNC (for 3300/90.16) 3300/90.17
ADFA Non-Conductive Antenna Mast Mounting Kit 3300/90.23

Antennas* Part number
Automatic DF-Antenna 2 Basic Set, 10 MHz to 8 GHzm 3361/101

*There is a separate DF antenna datasheet, which provides detailed information about the direction-finding antennas available 
from Narda.

m Requires Option 3310/95.005 “Option, Automatic DF Antenna Control, Bearing View”
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Narda Safety Test Solutions GmbH
Sandwiesenstrasse 7
72793 Pfullingen, Germany
Phone +49 7121 97 32 0
info@narda-sts.com

www.narda-sts.com

Narda-MITEQ
North American Sales Office
435 Moreland Road
Hauppauge, NY11788, USA
Phone +1 631 231 1700
info@narda-sts.com

Narda Safety Test Solutions S.r.l.
Via Benessea 29/B
17035 Cisano sul Neva, Italy
Phone +39 0182 5864 1
nardait.support@narda-sts.it

Narda Safety Test Solutions GmbH
Beijing Representative Office 
Xiyuan Hotel, No. 1 Sanlihe Road, 
Haidian
100044 Beijing, China 
Phone +86 10 6830 5870 
support@narda-sts.cn

® Names and Logo are registered trademarks of Narda Safety Test Solutions GmbH – Trade names are trademarks of the owners.

SignalShark Family
There are several different instrument types in the SignalShark family:  
SignalShark Handheld, SignalShark Remote Unit, SignalShark Outdoor Unit Modem R[n] Basic Set and SignalShark EMF  
Monitoring System, R[n]. 
For more information, please visit our website www.narda-sts.com
SignalShark Handheld SignalShark Remote Unit

SignalShark Outdoor Unit SignalShark EMF

Narda DF Antennas Datasheet SignalShark Command Reference Guide
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